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Chapter 1 Droplet Digital PCR Overview
Droplet Digital™ PCR (ddPCR™) is a digital polymerase chain reaction method based on water-oil
emulsion droplet technology. Using reagents and workflows that are similar to Taqman probe-based
design, ddPCR employs a combination of microfluidics and proprietary surfactant chemistries to divide
each sample into a high volume of water-in-oil droplets per well.

In general, ddPCR can be performed on the instrument with all types of DNA sample. However, individual
sample type compatibility for digital PCR applications might require a dedicated assay validation by the
end-user. The extraction method used, as well as sample purity, can influence sample compatibility for
digital PCR applications.

ddPCR Advantages
ddPCR achieves high performance in the following areas:

n Absolute quantification of target DNA copies in samples to determine precise concentrations without
using standard curves; this technique is ideal for nucleic acid target sequence measurements, viral
titer concentrations, or microbial load determination

n More precise measurement of differences in gene copy number to better identify genomic alterations
that indicate phenotypic variability, complex behavioral traits, and disease

n Detection of rare mutations or sequences in complex samples, such as a few tumor cells in a wild-
type background

n Absolute quantification of gene expression levels, particularly involving low-abundance microRNA

n Next-generation sequencing (NGS) quantification to increase sequencing accuracy, validate
variations/mutations, and reduce run repeats

n Low copy number quantification and gene expression of individual cells required by the high degree
(10-fold to 100-fold) of cell-to-cell variation in gene expression and genomic content among
homogeneous post-mitotic, progenitor, and stem cell populations

n Fast, precise, and cost-effective assessment of HDR (Homology directed repair) and NHEJ (non-
homologous end joining) generated by CRISPR-Cas9 or other genome editing tools to detect
genome edits

n Partitioning of the sample in ddPCR enables higher precision and more reliable measurement of
small differences in the target DNA sequences.
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Chapter 1 Droplet Digital PCR Overview

n High-copy samples and background are diluted, effectively enriching the concentration in partitions
with positive targets. Increased signal-to-noise ratio allows for the sensitive detection of rare targets
and enables a ±10% precision in quantification.

n Error rates are reduced by removing the amplification efficiency reliance of qPCR, enabling accurate
quantification of targets to near zero.

n For absolute quantification, there is no requirement for a standard curve.

ddPCRWorkflow
The ddPCR process adheres to the following workflow:

n Experiment prep— samples are prepared by combining DNA or RNA with primers, probes dye, and
Bio-Rad ddPCR supermix.

n Droplet generation— samples are fractionated into thousands of droplets in each well, with target
and background DNA distributed randomly into the droplets during the partitioning process.

n Thermal cycling— following droplet generation, the droplets are run through the thermal cycler,
which performs PCR amplification of the nucleic acid target in each individual droplet.

n Droplet reading— Each droplet is scanned (read) to determine the fraction of positive droplets in the
original sample. Poisson statistical formulas are used to determine the absolute quantity.

Note: Positive droplets containing at least one copy of the target DNA molecule exhibit
increased fluorescence, as compared to negative droplets. Poisson statistical formulas are used
to determine the absolute quantity.

Finding Out More
You can visit bio-rad.com to download product information, technical notes, videos, and user manuals
related to ddPCR instruments and technology.
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Chapter 2 System Overview
This chapter briefly describes the QX700™Droplet Digital PCR System components and the intended
use of the system. For comprehensive information on each instrument model, see the QX700 Droplet
Digital PCR System Instrument Guide (catalog no. 10000171493).

Intended Use
Important: The instrument and software are intended for Research Use Only and are NOT for use
in diagnostic procedures.

The QX700 ddPCR System is used to configure, run, and analyze experiments that produce DNA target
data. The system is intended for qualified personnel who are trained in molecular biological techniques,
as well as system care and use. Before using the QX700 ddPCR System, you must complete all required
training provided by Bio-Rad.

This user guide contains information on analysis features for the Premium Edition. For information on the
setup and run execution features in the QX700 ddPCR System Control Software, refer to the QX700
Droplet Digital PCR System User Guide (catalog no. 10000171493).
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Chapter 2 System Overview

QX700 ddPCR System Models
To support your organization's throughput needs, the QX700 ddPCR System is available in the
configurations described in Table 1. For detailed information on instrument capabilities, refer to the
QX700 Droplet Digital PCR System User Guide (catalog no. 10000171493).

Each model of the QX700 ddPCR System performs a three-step process to produce experiment data on
DNA and RNA targets. Droplets are generated, DNA is amplified using PCR, and then droplet data is
scanned (read) in up to seven fluorophore channels.

Category
QX700 E
(Essential)

QX700 S
(Standard)

QX700 HT
(High Throughput)

Throughput
(samples per run)

Up to 48 Up to 192 Up to 384

Time to results ~2.5 hrs ~4.5 hrs ~8 hrs

Description Entry-level model
designed for basic
throughput needs and
cost-sensitive labs

Balanced option that
offers higher sensitivity
and moderate
throughput

Premiummodel
optimized for high-
throughput environments

Recommended
for...

Smaller-scale
applications or labs just
beginning to use digital
PCR

Labs requiring more
robust performance, but
without the scale of HT

Large-scale screening,
biopharma, and CRO/
CDMO applications

Table 1. Instrument models
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Associated Software Applications

Associated Software Applications
The QX700 Droplet Digital PCR System includes the software applications described in Table 2, which
are designed to support experiment setup, instrument operations, and data analysis. The data service
application is also installed with Premium Edition to meet regulatory requirements. For more information,
see Using Premium Edition on page 15.

The applications are installed on the instrument and accessible from the touch screen but you can also
install the software on one or more PCs to maximize capabilities for setting up and analyzing experiments
while instruments are in use for run processing. For information on installing the software, see Installing
QX700 ddPCR System Analysis Software on page 134.

Premium Edition requires the user to log into the data service and applications, and reverify login
credentials when using auditable functionality.

Software Used to...

QX700 ddPCR System Control
Software, Premium Edition

Set up and run ddPCR experiments on the instrument, with added
functionality to support CFR 21 Part 11

QX700 ddPCR System Analysis
Software, Premium Edition

Analyze droplet data acquired by the instrument and the calculated
absolute concentrations of the targeted nucleic acids, with added
functionality to support CFR 21 Part 11

QX700 Data Service Manage user accounts and ensure compliance with 21 CFR Part
11; required for Premium Edition

Table 2. Supporting software applications
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Chapter 3 Using Premium Edition
This chapter explains the additional functionality included in the Premium Edition of the QX700 ddPCR
System Analysis Software. Premium Edition can enable your organization to meet the Food and Drug
Administration (FDA) regulations imposed by good laboratory practices (GLP) and good manufacturing
practices (GMP) in pharmaceutical and biotechnology environments. It also provides the necessary
features for the QX700 Droplet Digital PCR System to operate in compliance with Title 21 of the U.S.
Code of Federal Regulations Part 11 (21 CFR Part 11), within a closed system1.

21 CFR Part 11 Compliance
In Premium Edition, QX700 ddPCR System Analysis Software operates in conjunction with QX700 Data
Service, which functions as the system user account manager and ensures compliance with all 21 CFR
Part 11 operations. For information and instructions regarding the QX700 Data Service, refer to the
QX700 Droplet Digital PCR System Instrument Guide (catalog no. 10000171493).

Important: To be secure and in compliance with 21 CFR Part 11, the security controls built into
QX700 ddPCR System Analysis Software must be properly configured and administered by the
system administrators in your organization. Bio-Rad Laboratories, Inc. makes no claim that the
QX700 ddPCR System Analysis Software is 21 CFR Part 11 compliant in and of itself, nor does the
company guarantee compliance for the user. Your organization must establish policies and standard
operating procedures (SOPs) that work in conjunction with the QX700 instrument and software
provided by Bio-Rad to ensure compliance with 21 CFR Part 11.

Table 3 on page 16 describes how the QX700 ddPCR System Analysis Software complies with each
applicable section of 21 CFR Part 11.

1A closed system is defined as “an environment in which system access is controlled by the persons who are responsible for the content
of electronic records that are on the system”.
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Chapter 3 Using Premium Edition

Section Function
Customer

responsibility Compliance

11.10 (a) Validation Yes System validation, as well as experiment
results validation, is supported by QX700
ddPCR System Control Software and
QX700 ddPCR System Analysis Software.

Validation SOPs for the customer
organization are required.

11.10 (b) Human-readable
records

N/A Electronic records in human-readable
format are supported throughout QX700
ddPCR System Control Software and
QX700 ddPCR System Analysis Software.

11.10 (c) Protection of
records

Yes All electronic records are maintained within
the QX700 ddPCR System Control
Software and QX700 ddPCR System
Analysis Software environment until you
transfer them to external electronic
archives that comply with customer
organization policies.

11.10 (d) Limited system
access

Yes Access to QX700 ddPCR System Control
Software and QX700 ddPCR System
Analysis Software is controlled through
individual user authentication.

The customer organization is responsible
for establishing and maintaining the
appropriate list of user accounts.

11.10 (e) Audit trails Yes QX700 ddPCR System Control Software
and QX700 ddPCR System Analysis
Software tracks changes in an audit trail
that does not expire.

The customer organization is responsible
for creating and controlling backups.

Table 3. 21 CFR Part 11 compliance features
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21 CFR Part 11 Compliance

Section Function
Customer

responsibility Compliance

11.10 (f) Operating system
checks

Yes QX700 ddPCR System Control Software
and QX700 ddPCR System Analysis
Software provide guidance and checks for
setting up experiments.

QX700 ddPCR System Control Software
and QX700 ddPCR System Analysis
Software allow you to create custom
standard experiments that can, following
validation by the user, be released for
routine workflows.

11.10 (g) Authority checks Yes Access to QX700 ddPCR System Control
Software and QX700 ddPCR System
Analysis Software is controlled by individual
authentication and user role assignments.

Users cannot modify electronic records;
modification requires specified permissions
and validation before release into the
routine workflow.

11.10 (h) Device checks Yes Experiment configuration and parameters
are checked by QX700 ddPCR System
Control Software and QX700 ddPCR
System Analysis Software.

The customer organization is responsible
for sample ID input and standard
experiments validation.

11.10 (i) Determination of
education

Yes User guides and training documentation
are provided by Bio-Rad Laboratories, Inc.

The customer organizaiton is responsible
for establishing and maintaining the
appropriate training levels.

11.10 (j) Written policies Yes Not available

The customer organization is responsible
for establishing and maintaining SOPs to
comply with the regulations.

Table 3. 21 CFR Part 11 compliance features, continued
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Chapter 3 Using Premium Edition

Section Function
Customer

responsibility Compliance

11.10 (k) System
documentation

Yes Users cannot change QX700 ddPCR
System Control Software and QX700
ddPCR System Analysis Software
documentation.

The customer organization is responsible
for distribution to users and version control .

11.100 (a) Electronic
signature, general
requirements

Yes Unique to individual users

11.100 (b) N/A Verification of identify

11.100 (c) N/A Certification of equivalence

11.200 (a/b) Electronic
signature,
components and
control

N/A Signature with username and password
ensure a genuine owner

11.300 (a) Controls for
identification (user
names and
password

Yes Uniqueness of username and password

11.300 (b) Yes Periodic check of issuance

11.300 (c) Yes Loss management

11.300 (d) Yes Safeguards and detection of unauthorized
attempts

Table 3. 21 CFR Part 11 compliance features, continued
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QX700 Data Service Permissions
Each user role in the QX700 Data Service provides authorized users with access to a set of predefined
permissions for the QX700 Droplet Digital PCR System and QX700 ddPCR System Analysis Software.
Permissions are managed in the Roles/Permission tab on the QX700 Data Service user interface, where
all available permissions are displayed in a list format. Granted permissions for a user role are indicated
by a selected checkbox.

QX700 ddPCR System Analysis Software provides the permissions explained in Table 4.

User Role Permission Description

Assay Edition Provides access to assay editing

Export Data In addition to analytical data included in the 21 CFR Part 11 Regulatory
Report, the Export Data permission allows the authorized user to export all
data files listed using QX700 ddPCR System Analysis Software. The
preselected data elements (greyed out) are always part of the data export.
You can select checkboxes to export additional information.

Important: Once exported, you can edit the data in Excel and .csv files
outside the QX700 ddPCR System Analysis Software environment,
without being recorded in the experiment audit trail. Therefore, only
Sample Results reported within the generated PDF report are
compliant with 21 CFR Part 11.

Generate PDF Report The Generate PDF report permission allows the authorized user to create
and export a 21 CFR Part 11-compliant PDF report of an electronically
signed experiments using QX700 ddPCR System Analysis Software. The
user can include the experiment audit trail information as part of the PDF
report.

Important: To electronically sign an experiment, the Validate
Experiments permission is required.

Table 4. QX700 Data Service permissions
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User Role Permission Description

Invalidate Experiments The Invalidate Experiments permission allows the user role to remove an
existing electronic signature that was executed by a different user. After the
signature is removed, the user role can edit the data.

Important: In GMP and GLP environments, where a high level of
security is necessary, results must be reviewed by a second person as
a control mechanism. Under this rule, access to data and actions to
modify data results must always be available to more than one
authorized user (two-person, four-eyes principle). The Invalidate
Experiments permission supports the second reviewer hierarchy with
full compliance for 21 CFR Part 11.

For more information, see Electronic Signatures on page 21.

Validate Experiments The Validate Experiments permission allows the authorized user to verify
the result of the experiment for each individual sample in the experimental
run in QX700 ddPCR System Analysis Software Result Table.

The Validate Experiments permission further allows the user to
electronically sign the validated result of the entire experiment in the
Regulatory Report page of the QX700 ddPCR System Analysis Software
Export menu.

For more information, see Sample Validation on page 21 and Electronic
Signatures on page 21.

Table 4. QX700 Data Service permissions, continued

Individual User Authentication
To be compliant with 21 CFR Part 11, your organization must ensure that only authorized individuals are
able to access Premium Edition. Therefore, you must log in to the software using your individual user
authentication credentials (username and password).

Important: Failed logins might occur due to typing errors, but can also occur because of a
connectivity issue to the QX700 Data Service. After three failed attempts to log in, the account is
locked and only an IT administrator can reset and reactivate your Windows account.

If your session expires due to inactivity, Premium Edition requires a login to re-enable the screen. If
another user logs in before you return, or if the application is closed, any unsaved data is lost. Automatic
logout requirements are managed by your organization, but Bio-Rad recommends that you save your
work and then close the QX700 applications if you must leave them unattended.
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Sample Validation
Before you can sign and export the experiment results, QX700 ddPCR System Analysis Software
software requires each individual sample to be reviewed and flagged as valid or invalid. Sample
acceptance criteria might vary, depending on the specific SOP for an application or assay. Therefore,
your organization must define sample conformity criteria using the QX700 ddPCR System within the
application area.

Individual samples are flagged in the Valid Sample or Invalid Sample columns in the Results Table in the
View Result display. By default, the status of all samples is undefined, so you can apply the same status
to a selection of samples.

u Press the SHIFT or ALT key and select the samples, and then click the desired validity status.

Note the following for sample validation for pooled chambers:

n When using the Pooled Chamber feature, the experiment validity status of the individual sample
chambers cannot differ from the pooled chamber sample result.

n If the validity status of all individual sample chambers composing a pooled chamber sample result are
consistent, the validity status of the pooled chamber sample is implicitly set to the same value.

n If the validity status of the individual sample chambers selected for pooling differ, the validity status of
the pooled chamber sample remains undefined.

You can also assign a validity status for the pooled chamber sample directly. This overwrites the
individual sample validity status to match the pooled chamber sample validation status.

Electronic Signatures
In QX700 ddPCR System Analysis Software Premium Edition, you can electronically sign all validated
experiment results, provided that you are assigned the required permissions. Electronic Signature is
available in the Regulatory Report section of the Export view and is structured as follows:

n Electronic Signature Status displays a summary of the electronic signature status for the individual
experiment file (signed file record, signature user identification record, signature meaning record, and
signature date and time record)

n Sample Validity displays the record (summary) of the concluded sample results for the experiments
(valid samples,invalid samples, and unflagged samples)

Important: To electronically sign an experiment, you must first flag the result of all samples in
the experiment file as valid or invalid in the Result Table. If the samples are not flagged, an
advisory message appears in the Perform Electronic Signature section and you cannot proceed
with electronic signature.
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Chapter 3 Using Premium Edition

n Perform Electronic Signature (execution of the electronic signature for the experiment file)

n Meaning of Signature

o Default value is set to display “n.a.”

Important: In GMP and GLP environments, results must be reviewed by a second person
as a control mechanism for a higher level of data security. Use the Meaning of Signature
field to establish a result release hierarchy, tailored for your organization and fully compliant
with 21 CFR Part 11.

o Electronic signature definitions must be stated within the specific organization process.

n Sign

o To electronically sign the experiment file, you must log in with your user name and password to
confirm and authenticate. The user acknowledges full accountability and responsibility for all
actions initiated to generate the reported ddPCR results

Note: Once the experiment is signed, a signature icon appears to the right of the
experiment name in the top left corner of the experiment.The signature icon is a visual to
affirm that the experiment has been electronically signed and is locked to prevent any
further modifications. Subsequently, all QX700 ddPCR System Analysis Software features
that allow modifications to the experiment file are disabled throughout the software menu.

n Unsign

The user can click Unsign, and then log in to confirm removal of the electronic signature

Important: To unsign an experiment that was electronically signed by a different author, you
must be assigned the Invalidate Experiment user permission; otherwise, a "permission denied"
message appears.
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Experiment Audit Trail
The experiment audit trail records all events for an experiment file in QX700 ddPCR System Control
Software and QX700 ddPCR System Analysis Software. Events included in the experiment audit trail
record are:

n Scanning template parameters

n Cartridge IDs

n Scanning parameter modifications

n Droplet recognition modifications

n Sample modifications

n Experiment loading

n Spill-over compensation modifications

n Threshold or polygon position modifications

n Post-processing modifications

n Electronic signature record of the experiment file including user identification and date and
timestamp.

n Experiment design (pooling chambers, importing, setting, or removing assays and protocols, and
enabling or disabling chambers)

n Starting or canceling a run

n Rescanning chambers

n Changing a run priority

The experiment audit trail does not track events related to the Export functionality, since export events are
not in the scope of the Regulatory Report page. To produce a consistent experiment audit trail, all
computers running the software must be configured with the correct date and time.

You can review the experiment audit trail in QX700 ddPCR System Analysis Software.

To open the experiment audit trail viewer

1. Click Export in the menu bar, and then click the Regulatory Report tab.

2. In the Regulatory Reporting section click Display (below Audit Trail).
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Creating the Regulatory Report PDF
Important: The experiment Regulatory Report can only be created if the experiment file is signed
electronically. All date and time stamps are displayed with the ISO 8601 format. For information, see
Electronic Signatures on page 21.

To export the Regulatory Report:

1. In the menu bar, tap/click Export > Regulatory Report.

2. In the Regulatory Reporting section under PDF Report, tap/click Generate Report.

3. (Optional) Below Generate Report, select the applicable checkboxes to include the audit trail
information and individual chamber report.

4. Choose the location to save the file and click OK.

When the report is exported, the file is automatically opened in the default PDF viewer. You can print
the report in letter-size or A4 format.

The Regulatory Report is not editable and includes the following information:

n Experiment name

n User and software traceability, including

o Electronic signature operator, date, and time

o Electronic signature meaning (used for the second signature)

o Scan operator, date, and time

o Report generation operator, date, and time

o Software name and version used to create the Regulatory Report

o Software name and version used to scan the chambers

n Experiment and analysis setup information section, including

o Instrument type identification

o Instrument serial number

o Cartridge type

o Mix type

o Standard experiment status

o Number of analyzed chambers
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o Number of analyzed samples (considering pooled chambers)

o Spillover compensation matrix

o Thresholding scope (common to all chambers or individually per chamber)

o Thresholding type (lines or polygons)

o Scanned channel information

n Channel name

n Fluorophore name

n Target name

n Time exposure

n Thermal cycling program information, including

o Protocol ID

o Protocol name

o Altitude profile

o PCR program steps

o Layout of the protocols in the cartridges of the cartridge plate

n Cartridge layout for each cartridge plate

o Cartridge ID

o Chamber ID

o Sample name

o Pooling ID (if chambers are pooled, the pooling ID is written between brackets next to the
Chamber ID)

o Protocol ID

o Post-processing setup, describing the type of post-processing analysis and the target and
reference populations
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n QC Indicators, including (for each individual chamber)

o Chamber ID

o Sample name

o Chamber context

o Image sharpness quality for a chamber

o Number of analyzable droplets for a chamber

o Number of saturated objects for a chamber

o Quality flag for a chamber (green flag = HIgh, green flag with eye = Medium, and
yellow flag = Low)

n Result Table (for each individual chamber and pooled chamber)

o Cartridge ID

o Chamber ID

o Chamber context

o Sample name

o Sample validity status

o Protocol tag

o Population name

o Dilution factor

o Concentration

o Number of positive droplets per population

o Number of negative droplets per population

o Separability score

o Minimum concentration

o Maximum concentration

o Relative uncertainty

Note: Chambers in the QC Indicators Table and the Results Table appear in the same order, as
they appear in the QX700 ddPCR System Analysis Software. Populations that appear in the
results table correspond to the populations that visible in the software.
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n Footer section including

o Report generation operator, date, and time

o Experiment name

o Current page and total number of pages

The Regulatory Report can also include the following two optional sections if they are selected:

n Individual and pooled chamber level information, including (for each individual chamber and each
pooled chamber)

o Pooling/chamber name

o Pooling/Chamber Details section, including

n Chamber ID

n Sample name

n Chamber/Pooling context

n Pooling ID

n General quality flag for pooling

n Image sharpness quality for chamber

n Number of analyzable droplets for chamber

n Number of saturated objects for chamber

o Sample type per channel

n U = unknown

n P = positive

n N = negative

n S = standard

n Dilution factor
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o Chamber/Pooling Result section, including

n Sample validity status

n Total number of droplets per chamber / pooling per channel

n Dilution factor

n Concentration

n Number of positive droplets

n Number of negative droplets

n Minimum concentration

n Maximum concentration

n Relative uncertainty

n Separability score

o 2D plots, as configured in the 2D dot plot tab in the Plots & Populations tab.

n Experiment audit trail
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Chapter 4 Experiment Analysis Overview
In this guide, an experiment is defined as a set of samples that are processed by the QX700 Droplet
Digital PCR System using the droplet generation, thermal cycling, and droplet scanning (reading) ddPCR
functions.

Samples are run through the instrument in a cartridge plate containing up to three RDG16 cartridges.
During the experiment run, the system applies the scanning parameters, embedded file instructions, and
experiment details to the samples in each chamber. When the run concludes, the system creates a
.niodata file for analysis in the QX700 ddPCR System Analysis Software.

When you open the experiment file, the Plots & Populations view in the Analyze Data tab appears by
default.

Important:When you save a .niodata file in the analysis software, it is always saved as a .nioresult
file (whether or not you make changes) so the .niodata file remains in its original state.
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Analysis Process Workflow
User analysis in the QX700 Analysis Software typically adheres to the following general workflow.
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Opening an Experiment and Logging In

Opening an Experiment and Logging In
You can open the QX700 ddPCR System Analysis Software from the instrument touch screen or a
Windows computer. For information on installing the software on computers, see Appendix A, Software
Installation.

Premium Edition requires a login to open the software, and also to confirm auditable actions. For more
information on using Premium Edition, see Using Premium Edition on page 15.

To open an experiment

1. Tap/click or double-click the software shortcut ( ).

2. Enter your user ID and password, and then tap/click Log in.

3. When the Experiments dialog appears, do one of the following to open a .niodata or .nioresult file:

n Tap/click Open and navigate to the data file storage location to select the file

n Select a recent file from the list.

Note: After first use, up to ten most recently opened files appear in the Recent files list to
facilitate subsequent access. If you close the Open file dialog before you select a file, the
blank experiment layout remains. You can tap/click File > Home to reopen the Experiments
dialog.
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The .niodata and .nioresult files open to the Populations & Plots display in the Analyze Data tab. Data
files can take a few minutes to load.

The 1D dot plot view appears by default, and all chambers in the left pane are automatically selected.

Note: After the file opens, you can use the I/O menu to load compatible configuration files for
spillover compensation matrices, plots, and analysis. For information on the file types, see I/O
Menu on page 39.
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Accepted File Types and File State Indicators
The QX700 ddPCR System Analysis Software accepts the file types specified in Table 5.

File type Description

.niodata Original data file generated by the QX700 ddPCR System Control Software

.niodata files contain the original high-quality images required for image analysis.
Experiments that are opened for first-time analysis open in .niodata format.

Note: The .niodata file type has been reduced in size but might still take a few
minutes to open.

.nioresult Post-analysis file generated by the QX700 ddPCR System Control Software when the
original .niodata file is saved.

When you save a .niodata file after making changes, the analysis software creates a
.nioresult file with the changes and keeps the .niodata file in its original state so the initial
data is preserved.

.ncp Plot configuration file

.ncp files include axis labels, scale type (linear or logarithmic), and the plot page sequence
in the histogram, 1D dot plot, and 2D dot plot configurations.

.nca Analysis configuration file

.nca files include the following information for all data analysis parameters:

n Manual or automated thresholding strategy

n Thresholding mode and scope

n List of the populations (default or custom) with their name, color, and zones

n Coordinates defining each zone, such as threshold values for lines or vertex
coordinates for polygons).

.ncm Compensation matrix format

.ncm files contain the compensation parameters applied to the signal for each channel;
they are specific to the assay and assay conditions, but are independent of exposure time.

Table 5. QX700 data and configuration file formats
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Table 6 contains information on symbols that appear next to the experiment name.

File state Symbol Description

Modified, but not
yet saved

* When an asterisk (*) appears next to the file name,
the file has unsaved changes. Otherwise, no
changes were applied to the file since it was
opened.

When an asterisk (*) is used in a plot (next to
fluorophore names), the experiment is NOT
compensated. Asterisks can appear the x-axis and
y-axis.

Compensated When a grid icon with a check mark appears after
the experiment name (above the Chamber Pane),
spillover compensation has been applied.
Validation requires that a compensation file is
loaded in the QX700 ddPCR System Control
Software.

Table 6. File state indicators
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General Navigation Options
If you are using the instrument touch screen you can tap the different screen elements and options. If you
are using a Windows PC with a keyboard and mouse, you can use the following navigation and selection
options:

n Scroll a list using the mouse roller

n Zoom in and out of a graph using the mouse roller

n CTRL-click to select multiple files

n SHIFT-click to select multiple sequential files

n Right-click and drag to rotate a graph (3D amplitude plots only)

n Left-click and drag to move the graph and the rotation center (3D amplitude plots only)

n Double-click to reset the view icon description

n Click to drag and drop

Note: Some sections of this guide cite specific navigation options for the specified functions.

Channel Fluorophores and Colors
In the QX700 ddPCR System Analysis Software, the fluorophores cited below correlate to the specified
color and channel.

Fluorophore Color Channel

FAM Blue Channel 1

HEX Teal Channel 2

ROX Green Channel 3

Atto-590 Yellow Channel 4

Cy5 Red Channel 5

Cy5.5 Infra-Red Channel 6

Atto-550 Purple Channel 7
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Chambers Pane
The term "chamber" indicates a sample well in the RDG16 cartridge. The QX700 ddPCR System can
accept up to three RDG16 cartridges per run, for a total of 48 chambers. The left pane, which contains the
list of scanned chambers in each cartridge, in the order they were processed, is accessible from each of
the functional tabs in the top menu bar. A quality indicator appears to the right of each chamber. For
information on the quality indicators, see Performing Quality Control on page 43. The experiment name is
also shown above the chamber list.

Chambers are named per the following naming convention:

<RDG16 cartridge ID>-<chamber ID>_<sample name>

Each segment of the chamber name is explained in Table 7.

Component Description

Cartridge ID Unique barcode of the cartridge containing the chamber; this information is typically
filled in the QX700 ddPCR System Control Software as the cartridge barcode.

Chamber ID Position of the chamber in the cartridge (A, B, C, and so forth from top to bottom)
followed by the column index of the chamber on the cartridge (1 or 2 from left to right);
this information is automatically defined by the software (for example, A1 or D2).

Sample Name Name of the sample in the chamber

Table 7. Chamber naming segments
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Analysis Software Views
The QX700 ddPCR System Analysis Software provides the main views specified in Table 8.

Tab General Purpose For more information, see...

Quality Control View droplet quality Performing Quality Control on page 43

Setup View/edit experiment parameters Modifying the Experiment Setup on page
51

Analyze Data Analyze plot data and droplet images Data Analysis on page 73

View Results Review results table; analyze
concentration, uncertainty curve charts

Viewing Results on page 105

Post
Processing

Apply post-processing calculations Post-Processing Changes on page 117

Export Export selected details, data, and chart
graphics

Exporting System and Analysis Data on
page 123

Table 8. Main software views

Analysis Software Menus
The QX700 ddPCR System Analysis Software provides tabs and menus that allow you to

n Open and save experiments

n Load and save compensation and configuration information

n View experiment data quality

n Edit experiment setup

n Analyze experiment data

n View results (data tables and graphs)

n Apply post-processing calculations

n Export selected details, data, and chart graphics

n Save images

n View context-sensitive help pop-ups

User Guide | 37



Chapter 4 Experiment Analysis Overview

File Menu
To display the File menu

u Click File in the menu bar. The menu expands to show all options.

Using the File menu, you can

n Open .niodata and .nioresult experiment files

n Save experiments

When you save a .niodata file, it is saved as a .nioresult file. The original .niodata remains unchanged
to preserve data integrity.

n Return to the Home dialog containing the recent files list

n View software information

n Change the language

n Exit the software
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I/O Menu
Using the I/O menu, you can load and save the following file types to apply to the experiment:

n Spillover compensation (.ncm)

n Custom plot configuration (.ncp)

n Custom analysis configuration (.nca)

To open the I/O menu

1. Select I/O in the menu bar.

2. Select an option to open the submenu, and then select Load or Save. Follow the prompts to navigate
to the file or save the file, respectively. Each submenu contains the Load and Save options.
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Save Images Menu
The Save menu allows you to save or copy plots and other graphics.

Table 9 describes the available options. You can save the file with the existing file name or a new file
name.

Icon Option Description

Save image Saves the image in .png format

Save vector image Saves the image in .svg format

Copy image Copies the image to the clipboard, from which you can paste it into
another resource (graphics program, document, and so forth)

Table 9. Save menu options

To save or copy an image

1. Open the tab containing the image.

2. Tap/click the icon in the upper-right corner to open the menu.

Note: The displayed Save menu icon represents the last selection from the menu.

3. Tap/click Save Image, Save Vector Image, or Copy Image.
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4. Pause the arrow on the image or area to capture and then click the mouse button.

One of the following occurs:

n If you are copying, then the image is copied to the clipboard. You can paste the image into a
different resource (image editor program, document, and so forth).

n If you are saving, a Save as dialog opens. The default file name appears in the File name field.

5. To save the file:

a. (Optional) Navigate to a new storage location.

b. Enter a new file name or keep the default entry.

c. Click Save.

The image is saved as a .png or .svg file.

Help Menu
Use the Help menu to access context-sensitive tool tips that explain the selected functionality.
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Chapter 5 Performing Quality Control
The Quality Control tab provides the tools required to perform a visual inspection of the droplets in each
chamber and identify higher object saturation, which can result in high exposure time or artifacts.

A quality flag appears to the right of the chamber name. A flag is applied to each chamber to indicate the
assessed overall quality of the droplets. Each quality flag is described in Table 10.

Quality flag Description

A green flag indicates that all quality indicators are within expected specifications.

A green flag with an eye icon means that Bio-Rad recommends inspecting the droplets
visually to decide whether the result should be considered.

A yellow flag indicates that the system identified one or both of the following conditions:

n Too many artifacts were identified in the droplet image

n Too few (less than 1,000) detected droplets were countedin the chamber

Table 10. Chamber quality flags
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Options and information appear in the right pane are described in Table 11.

Option Description

Channel selection Tap/click a colored circle to view an image of the droplets in the corresponding
channel LED.

Contrast adjustment Tap/click the + or – icons to raise or lower the image contrast and brightness for
each selected channel.

You can also tap/click Auto to automatically adjust the contrast and tap/click
Reset to return to the original display.

Droplet exclusion Tap/click Exclude to exclude droplets in the chamber. You can also cancel the
action or restore the excluded droplets.

Legend The legend pane allows you to show or hide droplets as they are annotated
(artifact, analyzed, positive). Legend items correspond to the selected channel.

Number of analyzable
droplets

The higher the number the better the confidence in predicted concentration
results.

Number of
oversaturated objects

Te lower the number the better the chamber quality.

Important: Object oversaturation can apply to droplets subjected to high
exposure time, or to artifacts. To correct oversaturation, you can check
exposure times in QX700 ddPCR System Control Software to ensure they
are not too high, or you can clean the cartridge with an appropriate wipe to
remove dust or fluorescent elements that might have accumulated on the
foil. For information, refer to the QX700 Droplet Digital PCR System
Instrument Guide.

Table 11. Quality Control options
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The following graphics illustrate a droplet image for each indicator.

Fig. 1: Example of a droplet image in a chamber with acceptable data quality

Fig. 2: Example of a droplet image in a chamber flagged with the green eye
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Fig. 3: Example of a droplet image in a chamber with a yellow flag

Droplet Image Quality Control
Use the Quality Control display to analyze the droplet quality in each chamber. You can use the mouse
scroller to enlarge the droplet icons.
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Droplet Image Quality Control

To perform quality control

1. To access the quality control display and features, tap/click Quality Control in the menu bar.

2. Tap/click a chamber to display the image.

3. Tap/click a channel under Channel Selection.

4. Use the mouse scroller to zoom the image and identify artifacts, analyzed droplets, and positive
droplets for the selected channel.

The following legend identifies the indicator symbols:
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5. Show All is selected by default. To reduce the items in the display, clear Show All and then select one
or two of the items.

The indicators are described as follows:

n Red cross— Artifact (dust, undersized or oversized droplet, irregularly shaped droplet,
boundary droplet, and so forth. Artifacts are not counted as analyzable droplets

n Green cross— Negative droplet, which is counted as an anayzable droplet

n Green cross in a blue circle — Positive droplet, which is counted as an analyzable droplet

6. To navigate in and around the image, see General Navigation Options on page 35.

7. To select a different channel, tap/click a colored circle under Channel Selection.

8. To automatically adjust the image contrast, tap/click Reset under Contrast Adjustment.

Excluding Droplets
Oversegmentation (two or more droplet crosses instead of one) or undersegmentation (one droplet
instead of two or more) of the droplets might exist, which can lead to false positive or negative results.
Bio-Rad recommends that you manually inspect the droplets, as follows:

n Where there are red crosses, the software automatically rejects the droplets, and no action is
required.

n Where aberrant crosses are green, you must exclude themmanually.

Note: Artifacts are detected in the channel but some artifacts might exist and be visible only in other
channels, depending on the experiment/assay/chemistry used. Bio-Rad recommends that you check
all channels available in the experiment in case there are droplets that must be manually excluded.

To exclude droplets

1. To exclude one or several droplets considered as false positives (such as artifacts):

a. Right-click on each droplet to be excluded.

b. Tap/click Exclude under Droplet Exclusion.

Note: Excluded droplets are marked with yellow hexagons.
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Excluding Droplets

2. To exclude all droplets in an image region:

a. Press CTRL, and then right-click several times to define the polygon image region to exclude
(one click = one vertex).

b. Release CTRL to define the last polygon vertex.

c. Tap/click Exclude under Droplet Exclusion.

The following graphic shows a selection of droplet or polygonal image regions to be excluded. Before
you tap/click Exclude, droplet annotations are still visible in the yellow shape.

The following graphic reflects the removal of all selected droplet or image regions. After you tap/click
Exclude, droplet annotations are no longer visible in the yellow shape. All relevant droplets in the
polygonal region are removed from the analysis and marked with yellow color.

3. To cancel the current selection of droplets to be removed, tap/click Cancel under Droplet Exclusion.

4. To restore all the manually excluded droplets, tap/click Restore under Droplet Exclusion.
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Chapter 6 Modifying the Experiment Setup
The Setup tab includes the Edit Experiment and Compensate Spillover displays, which are briefly
described in the following bullet points:

n Edit Experiment—view data from the run and change configuration elements in the table. You can
also edit fluorophore and target names, add or remove chambers, and pool (merge) chambers for
higher detection sensitivity.
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n Compensate Spillover— load an existing compensation matrix that matches the experiment
parameters and apply it to the results. You can also manually edit the spillover compensation in the
grid that appears in the lower-right corner.

Important: Bio-Rad recommends that only expert users manually modify spillover
compensation values.
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Editing General Experiment Parameters
In the Edit Experiments view, the top pane contains the fluorophore names and target names, as well as a
Comments field. and the table contains chamber settings. Editable values are typically defined in the
QX700 ddPCR System Control Software. but they can be modified in the QX700 Analysis Software.

The assay and thermal cycling protocol that were specified in the QX700 ddPCR System Control
Software are also identified in the top pane and are not editable.

Note: If all chambers do not share the same assay and protocol, Bio-Rad recommends dividing the
experiment into chamber subsets using the pooling option and add/remove chambers option.

To edit global parameters in the top pane

1. In the Experiment Setup view, do any or all of the following:

n Tap/click in a Fluorophore name field and replace the existing entry.

n Tap/click in a Target name field and replace the existing entry with the name of a target of
interest.

n Tap/click in the Comments field to enter information about the experiment.

Important: Other information that appears in the top pane is read-only.
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To modify chamber settings

1. Press CTRL-click or SHIFT-click to select one or more chambers.

In the table, the column headings appear in the fluorophore (channel) color (Blue = FAM, Teal = HEX,
Green = ROX, and so forth)

2. Edit the the entries in the following columns:

n Sample type (U = unknown, N = negative, P = positive, and S = standard)

n Dilution factor (a value of 10 equals a 10-fold dilution)

Note: If the dilution factor is modified from 1 to 10, then the estimated stock concentration is
multiplied by 10. The updated dilution factor is considered in post-processing data
calculations, except for Linkage Analysis, which is always calculated at a dilution factor of 1.

Pooling Replicate Chambers
You can pool (merge) chambers containing the same sample (replicates) to increase detection sensitivity
and quantification precision.

By considering each set of pooled chambers as one large chamber, pooling increases the analyzed
sample volume and quantification accuracy. The higher the number of pooled chambers, the higher the
total number of analyzed droplets. This reduces sampling and partitioning errors, thereby increasing the
quantification certainty.
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After the chambers are pooled, QX700 ddPCR System Analysis Software automatically computes the
concentration of each target in the parent chamber and updates the predicted concentration data in View
Results > Results Table. One line is added for the parent chamber and the individual chamber identifiers
appear below.

For each detection channel, the sample type, reference concentration, and dilution factor appear in the
parent row.When you export the data, these new lines are exported in the same order in the Results sheet
of the exported Excel file, and the pooled chamber IDs appear in the Chamber_Details sheet.

Important: If you are using Premium Edition, individual chambers are automatically validated when
the pool is validated. Bio-Rad recommends that you corroborate the results.

To pool chambers containing the same sample

1. Tap/click Setup > Edit Experiment.

2. From the list of chambers on the left, select the chambers to be pooled.

The selected chambers are highlighted in the list.

3. Tap/click Pool.

If the chambers to be pooled do not contain the same settings, an advisory message appears per the
following example.
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4. Read the message and do one of the following:

n If the chamber selection is as intended, tap/click Proceed.

n To select a different set of chambers, tap/click Cancel and repeat steps 2 and 3.

A parent row is added to the table (Sample 7 in the following graphic).

5. Tap/click the arrow to the left of the parent ID to expand and display the individual chambers that
were pooled. The parent ID is appended to each.

6. To unpool the chambers, tap/click Unpool.

Note: Unpooled chambers return to the single-chamber format, but retain the third segment of
the chamber name assigned to the pooled chambers (such as Sample7).
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Combining Graphical Data for Multiple Chambers
Use the Plots & Populations tab to display selected chamber data side-by-side (1D dot plots) or
collectively.

To display 1D dot plots side-by-side

1. Tap/click the 1D Dot Plot tab.

2. In the left pane, press CTRL-click and select the chambers.

The plots for each selected chamber appear sequentially.

To combine chambers in 2D or 3D dot plots

1. Tap/click the 2D dot plot or 3D dot plot tab.
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2. In the left panel, press CTRL-click and select the chambers to be merged.

To combine the histograms

1. Tap/click the Histogram tab.

2. In the left panel, press CTRL-click and select the chambers to be pooled.

QX700 ddPCR System Analysis Software displays histograms according to pooled chambers.
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To combine the uncertainty curves

1. Tap/click the Histogram tab.

2. In the left panel, press CTRL-click and select the chambers to be pooled.

QX700 ddPCR System Analysis Software displays the uncertainty curves of the pooled chambers.

Adding or Removing Chambers
To add chambers from another experiment

1. Click the +Add Chambers icon and navigate to the experiment.

2. Select the .niodata or .nioresult file to be imported and tap/click OK.

Important: The parameters of the files (exposure times, compensation, image processing) must
match or an error message appears. Mismatched parameters can compromise concentration
and other results.

To remove chambers

1. Select the applicable chambers in the Chamber pane.

2. Tap/click Remove Chambers.
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Reordering Chambers

To reorder the chambers in the list

1. Select one or more chambers.

2. Tap/click the Move Up and Move Down arrows in the top pane, or tap/click a column heading to sort
in ascending or descending order.

Applying Spillover Compensation
When using different types of fluorophores on the QX700 ddPCR System, spectral overlap can
sometimes occur between two or more detection channels. To make proper adjustments for this
fluorescence spillover, you must apply a spillover compensation matrix for each assay using the
Compensate Spillover function in the Setup tab.

A compensation matrix corresponds to specific thermal cycling conditions and a specific multiplex assay
composed of oligonucleotides (probes and primers) and target sequence DNA. You should create a new
compensation matrix if either or both of the following changes are made to the experiment before the
chambers are processed:

n Primers, probes, or DNA target sequences are modified (such as a change in primer or probe
sequence or concentration)

n The thermal cycling program is modified
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In uncompensated experiments, the Spillover Compensation dialog appears per the example in Fig. 4.
Negative fields appear in the top row and contain a zero for each color. By default, all remaining values
are set to zero (0.0000000) except in each field where the fluorophores intersect, which contains
1.0000000.

Fig. 4: Matrix for an uncompensated experiment

Fig. 5: Matrix for a compensated experiment

After you apply the compensation matrix to the data, the spillover signal is removed from the dot plot. and
distance between clusters should be better defined to improve the the separability score. For more
information, see Quantifying Fluorescence Separability on page 111.

Important: The correction is not performed in the droplet image, since it was acquired by the
instrument. Therefore, a droplet can appear as positive in a channel without actually being present in
the corresponding dot plot.

After you compute a compensation matrix using one of the methods cited in this chapter to adjust the
thresholding in the chart, the fields that previously contained zeros are populated with the excitation
matrix coefficients where the fluorophores intersect with the other channels (Fig. 5).
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To compensate the fluorescence spillover

1. Tap/click Setup > Compensate Spillover.

Note: To change the matrix fluorophore labels, open the Edit Experiment tab and rename the
fluorophores in the top pane.

The QX700 ddPCR System Analysis Software displays the 2D amplitude plot. The following graphic
shows uncompensated data in the Compensate Spillover view.

2. To create or edit a compensation matrix, see Automated Method on page 63, Template-Based
Method on page 67, or Manual Method on page 68. Additional graphics illustrate how the dot plots
change in accordance with the spillover compensation.

Important: Unless you are an expert user, Bio-Rad recommends using the automated method
or the template-based method to compensate the spillover of an assay.
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Automated Method
To achieve more accurate thresholding of a multiplex assay, Bio-Rad recommends using the automated
method to create a compensation spillover matrix.

Important:When using the automated method, you should perform a monocolor control run first, to
produce one fluorescent signal per channel in each chamber. The control is composed of all PCR
reaction reagents for a given assay, with only one DNA target sequence present, as shown in Table
12.

Fluorophore
Channel
LED Target Description

Negative control N/A NNNNNNN No positive signal (no target)

FAM Blue PNNNNNN Target for FAM only

HEX Teal NPNNNNN Target for HEX only

ROX Green NNPNNNN Target for ROX only

Atto-590 Yellow NNNPNNN Target for Atto-590 only

Cy5 Red NNNNPNN Target for Cy5 only

Cy5.5 Infra-Red NNNNNPN Target for Cy5.5 only

Atto-550 Purple NNNNNNP Target for Atto-550 only

Table 12. Mono-color compensation controls

You must remove all but one target from the mix, leaving only the target of the desired fluorescence in any
given chamber. If you repeat for each fluorophore, then only a signal target is amplified, producing a
fluorescence signal that is higher than the background signal generating from the probes. One chamber
per channel, plus a negative, is required to compute a monocolor compensation matrix.
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To automatically compute a compensation matrix

1. After the data is generated from the monocolor experiment, tap/click Setup > Compensate Spillover,
and then tap/click Compute.

2. In the resulting dialog, tap/click the checkboxes to match the appropriate monocolor controls to the
chambers.

3. Tap/click Next.

QX700 ddPCR System Analysis Software automatically places a threshold in the 1D plots.
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4. (Optional) To adjust the values, drag and drop the threshold lines.

5. Tap/click Compute compensation.

QX700 ddPCR System Analysis Software displays the 2D dot plot, with the spillover compensation
applied to the data in a comparative view with the original clusters. The difference between the
uncompensated data (light gray) and the compensated data (dark grey) is displayed as a preview.
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6. If the cluster positions are correct (orthogonal to each other), tap/click Apply to apply the
compensation matrix to all the chambers.

7. Tap/click Save.

The compensation matrix is generated as a .ncm file, which you can reuse the file as a template for
other experiments if the same assay and thermal cycling conditions apply. For more information, see
Template-Based Method on page 67.
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Template-Based Method
If you already have a compensation matrix calculated and saved that matches the current experiment
conditions (same fluorophores, targets, and so forth), then you can use a template to resolve fluorescence
spillover.

Important: Two experiments with different scanning times can use the same compensation matrix,
since compensation matrices are normalized by the exposure time. However, the two experiments
must share the same assay conditions and thermal cycling program.

To use the template-based spillover compensation method

1. Below the compensation matrix layout, tap/click Load.

2. Navigate to and select an .ncm file and then click Apply.

The compensation values are imported into the matrix.

3. If necessary, edit existing values and click Save to save the matrix as a new .ncm file.

Note: You can also export the spillover compensation file using the Export function. For
information, see Exporting System and Analysis Data on page 123.

User Guide | 67



Chapter 6 Modifying the Experiment Setup

Manual Method
This method can be applied if neither the template-based method (see below) nor the automated method
(above) can be applied.

Important: The manual spillover compensation method is an expert function designed to address
non-specificity issues. It is not recommended unless you are an expert user and understand its
impact.

The following graphic illustrates the default compensation matrix view.
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To use the manual spillover compensation method

1. Tap/click Compensation Spillover, and then tap/click the Edit button below the matrix.

The uncompensated clusters appear in the 2D dot plot view.

Important: As with the automated compensation method, manual compensation is meant to
place the clusters in positions that are orthogonal to each other.

2. Enter coefficient values individually in the Spillover Compensation matrix or click the up and down
arrows. The fields containing 1.000000, in which the same fluorophore intersects, are not editable.

3. Set the negative values in the first line by entering the mean RFU value of the negative cluster in each
channel.
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After the compensation matrix has been manually modified, the compensated (dark gray) and
uncompensated (light gray) droplet populations overlap in the graph.

4. To apply the spillover compensation to the full experiment, tap/click Apply.

5. When the following message appears, tap/click Yes.

After the spillover compensation is completed, the spillover signal is removed from the dot plot. The
correction is not performed on the droplet image, since it was acquired by the instrument. Therefore,
a droplet can appear as positive in one channel (red in this example, due to spillover) without being
present in the red dot plot, since the compensation matrix removed the spillover signal.

6. To reset the spillover compensation and return to a non-compensated experiment, tap/click Reset.
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The following graphic shows the correctly compensated 2D dot plots.

The compensation matrix is generated as a .ncm file, which you can reuse the file as a template for
other experiments if the same assay and thermal cycling conditions apply. For more information, see
Template-Based Method on page 67.
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Chapter 7 Data Analysis
The Analyze Data tab contains the following analysis views:

n Plots & Populations—The Plots and Populations view illustrates the droplet data for each
fluorophore channel in 1D, 2D, 3D, and histogram dot plots. The default view is the initial three
fluorophores but you can prompt additional screens to show the dot plots for the remaining
fluorophores (up to seven) in larger experiments. You can also add and edit zones and populations
for different targets and change the thresholding type and scope.

n Explore Crystals—view the dot plots and droplet images using the options at the bottom of the
display. QX700 ddPCR System Analysis Software reloads the amplitude plot settings, which include
the displayed channel and the axis min/max values.

Continue to the following sections for information on all droplet analysis functionality.

Plots and Populations
When you open a .niodata file, the Analyze Data tab displays the Plots & Populations view by default.

All chambers are selected in the left pane and the software uses a range of up to seven (7) fluorescence
channels to display the droplets.
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For information on fluorophores and matching LED colors, see Channel Fluorophores and Colors on
page 35.

By default, thresholds are applied to the data automatically. If the fluorescence of the droplet is higher
than the defined threshold, then a droplet is considered positive; otherwise it is considered negative.

Plot Types
Droplets are measured by Relative Fluorescence Unit (RFU) and represented graphically in a variety of
plot displays (1D, 2D, and 3D dot plots, and histogram). A population editor is also available where you
can define custom populations within zones.

The following graphics display each plot type:

n Histogram

n 1D dot plot
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n 2D dot plot

n 3D dot plot

User Guide | 75



Chapter 7 Data Analysis

Line Thresholding Color View
The Color View pane appears in Lines thresholding mode, and shows all fluorophores in the experiment
matched to the LED color. Below the fluorophores, the color display combination icons (two, four, and
eight) and the population selector icon appear. Each icon is described in Table 13 on page 76. All
negative droplets are colored gray in the charts.

Icon Description

Two-channel display. For each fluorophore represented by a dot plot, the two-color view
mode displays positive droplets in the corresponding color and negative droplets in gray.

Four-channel display. For the two selected fluorophores in each dot plot, the four-color view
mode displays positive droplets as follows:

n Color A (for example, blue LED or FAM)

n Color B, (for example, teal LED or HEX)

n Colors A and B (blue and teal t represent FAM and HEX)

All negative droplets appear in gray.

Table 13. Color View icons
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Icon Description

Eight-channel display.

This view mode is only available for three-channel (FAM/Blue-ROX/Green-Cy5/Red/)
experiments and provides the different colors for single-positive, double-positive, or triple-
positive droplets, according to the corresponding color code in the Venn diagram1. The dark
background represents negative droplets across all channels.

Population selector. This mode allows you to visualize the droplets that are included in a dot
plot population to identify issues with clusters, compensation, and so forth.

To illustrate the negative and positive droplets for the defined populations (or population
combinations) in Population Selector mode, the 1D and 2D dot plots provide a color for
each channel by default. For example, if the user is viewing the FAM channel, all positive
droplets appear in blue and all negative droplets appear in gray.

Table 13. Color View icons, continued

1 To help the user understand the classes of droplet positivity combinations in a triplex experiment, QX700 ddPCR System Analysis

Software uses the 8-color Venn-style (rosace) diagram.
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The following example graphic shows positive droplets in the 1D dot plot when FAM is selected under
Color View and the Population Selector icon is selected.

The following example graphic shows positive droplets in the 2D dot plot when FAM is selected under
Color View and the Population Selector icon is selected.

Note: If the.niodata or .nioresult file contains data for more than three fluorophore channels, you can
use the plus and arrow icons under Plots Navigation to add and navigate to the remaining plots.
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Polygon Thresholding Zones and Populations
For 2D and 3D dot plots, you can define and apply polygon thresholding. You can change the thresholding
mode and scope, and then draw your polygons to create each population identifier.

Important: If you define polygons for your thresholding method, all previous thresholding (including
automatic line thresholding) is overwritten.

Use the specified population colors to define your polygons in the 2D or 3D dot plots.

Fig. 6: Defined polygons

Tip: If the.niodata or .nioresult file contains data for more than three fluorophore channels, you can
use the plus and arrow icons under Plots Navigation to add and navigate to the remaining plots.
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The polygons appear in the Zones pane after they are defined.

Changing Dot Plot Axis Values
u To edit defined axis boundary ranges, tap/click the icon in the lower-left corner of a graph (or

double-click on an axis).

In a 1D dot plot, only the vertical axis values, which represent the range of relative fluorescence intensity
(RFU) in the droplets, are editable. The horizontal axis label is read only and depends on the number of
chambers selected, as follows:

n If only one chamber is selected, "Droplet Index" appears

n If multiple chambers are selected, "Chamber Number" appears (1, 2, 3, and so forth).
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To modify axis values

1. Select a fluorophore from the Population Axis dropdown.

2. Enter new vertical axis values to define the upper and lower bounds.

The axis range is modified in the dot plot.

3. (Optional) In the remaining fields, change the dot size, dot opacity, and droplet order.

4. Repeat to modify the values in other 1D dot plots.

In a 2D dot plot, both the vertical axis and the horizontal axis are editable.

n The vertical axis displays the RFU of the droplets in one selected channel

n The horizontal axis displays the RFU of the droplets in another selected channel

1. Under Vertical Axis, do the following:

a. Select a fluorophore from the Population Axis dropdown.

b. Enter new vertical axis values to define the upper and lower bounds.
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2. Under Horizontal Axis, do the following:

a. Select a fluorophore from the Population Axis dropdown.

b. Enter new horizontal axis values to define the upper and lower bounds.

The axis range is modified in the dot plot.

3. (Optional) In the remaining fields, change the dot size, dot opacity, and select the checkbox to display
the heat map.

4. Repeat to modify the values in other 2D dot plots.
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Navigating 3D Dot Plots
In 3D plots, each axis represents the fluorescence value of the droplets in any given channel.

To display the 3D dot plots

u Tap/click Analyze Data > Plots & Populations, and then select the 3D dot plot tab to display the plots.

Note: To navigate in the 3D plot, see General Navigation Options on page 35.

User Guide | 83



Chapter 7 Data Analysis

You can also use the following icons:

Reset the view.

Project the view on the first and second axis.

Project the view on the second and third axis

Project the view on the first and third axis

Switch between black and white backgrounds

Modify the point size, the line width, the grid step or the population axis
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Reading Histograms
Use the histogram to view the negative population on the left and the positive droplet population on the
right, as well as to check and adjust the fluorescence thresholds. If you have selected multiple chambers,
then the number of droplets in each fluorescence bar are combined.

To view the histograms of the droplet fluorescence values

1. Tap/click Analyze Data > Plots & Populations > Histogram.

The histograms of the currently selected chambers are displayed for each channel, as follows:

n The x-axis shows the fluorescence value (in RFU)

n The y-axis shows the number of associated droplets.
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Adjusting Fluorescence Thresholds
QX700 ddPCR System Analysis Software considers the raw data from all samples in the experiment to
automatically estimate and apply fluorescence thresholds that separate positive and negative droplets.
Thresholds are redefined if you import a compatible spillover compensation matrix. For information on
compensation spillover matrices, see Applying Spillover Compensation on page 60.

Line thresholds are applied automatically in 1D and 2D dot plots by default, but you can switch to polygon
thresholding in the 2D plots. Thresholding considers the fluorescence points from all chambers to
maximize the inter-class variance (among the groups) and minimize the intra-class variance (within the
groups).

Important: The automated threshold estimation is more accurate if both positive and negative
droplet populations are represented in the experiment and in each channel; therefore, Bio-Rad
recommends that you include at least one negative control chamber and one positive control
chamber for each of the channels in the experiment (up to seven).

You can move (click and drag) the thresholds applied by the software to adjust the number of droplets
recognized as positive and negative. For more information on thresholds, see Using the Lines
Thresholding Mode on page 87 and Using the Polygon Thresholding Mode on page 89.
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Using the Lines Thresholding Mode
Line thresholding is the default thresholding method for 1D and 2D dot plots, and is applied automatically
when an experiment is loaded. For information on polygon thresholding (2D plots only) see Using the
Polygon Thresholding Mode on page 89.

Automatically Calculating Line Thresholds
1. Click Analyze Data and select the 1D dot plot tab.

2. Click Auto, as shown in the following graphic:

Each displayed channel value represents the estimated number of positive droplets.

Modifying Line Thresholds
As you review the automatically calculated thresholds for selected chambers in each fluorescence plot,
you can drag the lines to adjust the thresholds where necessary.

1. In the left pane, select the applicable chambers and then select the 1D dot plot tab.

Note: The multi-chamber view displays a separator between each chamber in the plot on the
horizontal axis (per the following graphic), and the original calculated collective threshold is
displayed.
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2. To manually adjust the fluorescence thresholds, select a threshold in one of the plots to drag and
drop the threshold line.

Note:When you click and drag the threshold line in one chamber, the threshold is redrawn for all
chambers. The dotted line represents the original threshold and the solid line represents the new
threshold.

When you adjust the threshold, the value changes for the corresponding channel under
Fluorescence Thresholds.

3. To apply the modified values, tap/click Apply under Fluorescence Thresholds.

Positive and negative droplets are recalcuated into a separability score for each population of
interest, and then exported as an advanced quality control file. Separability scores are used to
evaluate amplification efficiency. For more information on separability scores, see Quantifying
Fluorescence Separability on page 111.

Note: To discard the values before applying, click Cancel. To restore the automatic fluorescence
thresholds, click Auto.
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Using the Polygon Thresholding Mode
Polygons provide a flexible way in 2D plots to define or edit individual droplet zones, which are used to
identify a broader set of characteristics. Within a zone, you can build populations for additional granularity
in sample and target results. Populations can include positive and negative droplets, concentration,
confidence interval, and so forth. You can also define negative droplet zones.

Important:When you switch to Polygon thresholding, the existing zones and populations are
removed. Polygon thresholding is available for 2D dot plots only.

Use the following keyboard commands and mouse options to create, modify, move, and delete polygons:

n Press SHIFT and right-click to create a basic diamond polygon in one click.

n Left-click on an edge of the polygon to add a new vertex in the middle of this edge.

n Left-click on an edge of the polygon then drag and drop to move the polygon.

n Left-clicking inside a polygon does not move the polygon, but does move the 2D view.

n Left-click on any vertex of the polygon to modify its position.

n Right-click on a vertex of the polygon to remove the vertex.

n Right-click outside the polygon to remove it.

To create a polygon

1. Tap/click Analyze Data > Plots & Populations > 2D dot plots.

2. Under Thresholding Mode, select Polygons from the Type dropdown list.

All dots appear in gray before you apply polygon thresholds.

User Guide | 89



Chapter 7 Data Analysis

3. Do one of the following:

n If the Auto Population Creation checkbox under Polygon Edition is selected (default setting), use
SHIFT right-click in the 2D dot plot to create a polygon by the droplet cluster to be segregated.

The Population Attributes pop-up opens immediately, and you can use this method if you prefer
to create a polygon identifier and then immediately edit the polygon. Continue to Step 4.

n If the checkbox is cleared, you can tap/click Population Editor and then click Add Population.
You can use this method if you prefer to create all polygon identifiers first, and then create the
polygons. Continue to Step 4.
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4. In the Population Attributes pop-up, select a color to identify the population and then enter a
population name and click OK.

5. Tap/click OK to create the polygon identifier.

6. Repeat for each population identifier that you need for plot segregation.
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Modifying or Removing Polygon Thresholds
After you create polygons, you can edit them according to your needs and apply the changes:

1. To edit a polygon, click a polygon in the dot plot to display the vertex points and adjust the polygon
shape and size.

2. In the 2D plot view, you can localize polygons using the dropdown list under Definition Scope:

n To set the polygon thresholds uniformly across the whole experiment, ensure Common for all
chambers is selected for Definition Scope.

n To make adjustments to each polygon zone, chamber by chamber, ensure Individual by
chamber is selected.

3. Under Polygon Edition, you can

n Select a polygon and click Remove.

n Edit a polygon and click Apply.

n Cancel your changes.

n Select or clear the Auto Population Creation checkbox.
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Defining a Population in a Zone
A population is an entity defined by a zone or several zones. You can use the Population Editor to specify
which zones comprise a population.

Note: If the Automatically create population checkbox is selected, the Population Attributes pop-up
appears automatically after you draw your polygon. After you complete the information and tap/click
OK, the population appears in the Results table.

To edit your populations in the Population Editor

1. Tap/click Analyze Data > Plots & Populations > Population Editor.

2. For each population created, tap/click the population name to display the associated zones in the list
and in the plots, Venn diagram plots, Venn diagram view, and positivity combination view.
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In the Zones panel, several tabs provide different way of viewing the zones:

n In the Triple Rosace tab, a Venn diagram that provides a selection of single, double, or triple-
positive zones.

Note: The Triple Rosace tab is only enabled for experiments using the Cy5-FAM-ROX
(Red-Blue-Green) channels.

n Use the 2D Dot plot to view thresholds and polygons in a 2D space

n Use the 3D dot plot to view the channels that are related to the thresholds or polygons. In the 3D
view you can see the projection of a 2D polygon along the 3D axis of the 3D dot plot.

n Positivity Combination (only available) in Lines thresholding mode)

3. To change the color and population name, tap/click Edit.

4. To update the zones that are included in the population, change the checkbox associated to a zone.

Note:When viewing the zones in the 2D dot plot, select the 2D dot plot tab and then use one of
the following methods to select a zone:

n Tap/click a zone in the 2D plot display.

n Tap/click a row under Zones List. The selected zone is shown as selected in the table and
appears in the dot plot.

n Select the zone checkbox to include it in the currently edited population.

Note: You must tap/click Edit in the population list to select a zone for a population.
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5. To display the desired population, tap/click Population Editor in the menu bar and then select a
quadrant in the 2D dot plot tab.

6. Tap/click the Positivity Combination widget to display the status of the populations (positive,
negative, or undefined).

Note: This display is useful for creating and displaying populations. For example, you set the
FAM (Blue) channel to Positive and the other channels to Negative to create a Simple FAM
(Blue) Positive population.

By definition, the droplets included in the population are counted as positive droplets. By default, all
the droplets that are not included in the population are counted as negative droplets for this
population. Continue to the next section to learn how to define negative zones in a population.
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Defining Negative Zones
For some applications, such as Drop-Off, you might need to choose a specific droplet population and
define a negative zone.

To define a negative zone for a population

1. Select a specific zone and then select the 2D dot plot tab.

2. Select Polygons as the thresholding type and then create a new polygon.

3. Select the Population Editor tab and then select the population of interest.

4. In the Populations display, tap/click Edit > Need to define specific negative droplets.

96 | QX700 ddPCR System Analysis Software



Adjusting Fluorescence Thresholds

5. Select the negative droplets polygon and select the Negative checkbox, and then tap/click Apply.

The concentration calculation for the polygon of interest only considers the droplets detected in the
negative droplet polygon.

Populations for which specific negative droplets have been defined are indicated with an asterisk
symbol (*) appended to the population name, which indicates that the sum of positive and negative
droplets for the populations might not be equal to the total number of droplets. The asterisk is
displayed throughout the Result Table.

The column set appears in the View Results table.

User Guide | 97



Chapter 7 Data Analysis

Heatmaps
Heatmaps are convenient analysis tool to delimit 2D zones. In heatmap mode, the color map represents
the different droplet density levels in the fluorescence populations.

Droplet densities utilize a color gradient that is displayed on the second y axis. Low droplet densities are
represented by shades of gray on the lower axis (light grey) while increasing droplet densities are color
coded in shades of blue, green, yellow and red to scale to the highest droplet density.

To activate the heatmap visualization in 2D dot plots

u Open plots settings and tap/click the icon to opne the dialog.

The color scale on the right of the graph gives the complete color range that is used to represent the
different density levels.

Negative populations are typically very dense, which can hide smaller density variations between
less dense areas. You can modify the heatmap color scale parameter to highlight populations of
lower density levels. For example, when droplet clusters are not well separated, the heatmap feature
allows the definition of distinctive droplet clusters, as shown in the following graphic.
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The following graphic shows the heatmap activated.

The following graphic zooms into the 2D-dot plot and shows the placement of polygons in the
intersection of the two clusters guided by the heatmap color gradient (red indicating the most dense
population).

You can zoom out to deactivate the heatmap feature.
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Exploring and Analyzing Droplets
The Explore Crystals view provides multiple droplet displays, including 2D dot plots and droplet images,
that you can use for droplet analysis.

To analyze a droplet population using Explore Crystals

1. Tap/click Analyze Data > Explore Crystals, and then select a chamber from the list. You can analyze
one chamber at a time.

Note: To navigate in the chamber image, see General Navigation Options on page 35.

2. To change the detection channel, tap/click a colored circle under Channel Selection.
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3. To automatically adjust image contrast, tap/click Auto under Contrast Adjustment.

The following graphic displays the Explore Crystals view in 2D simplified color mode.

The following graphic displays a zoomed view of the droplet image.
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To highlight a specific droplet in the crystal image

1. Left-click on the quadrant of interest to activate or deactivate the highlighted droplets included in one
quadrant of a 2D graph,

The activated quadrant fill is transparent orange in the graph and the droplets included in this
quadrant are highlighted in their current color codes in the image.

2. Use the Population opacity cursor to adjust the opacity.

3. Press SHIFT > left-click to select multiple quadrants in a 2D graph and highlight multiple droplet
populations, as shown in the following graphic:

To highlight the droplets belonging to a given population

u Select the population name in the drop-down menu above the 2D dot plots.
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The associated zones (quadrants or polygons) are filled in transparent orange in the graph. The
droplets included in these zones are highlighted with the population color in the image graph
quadrants.

To highlight droplets included in any user-defined polygonal region of a 2D graph

1. Press CTRL right-click enough times to define the polygon region shape to be drawn (one click = one
vertex).

2. Release the CTRL key after defining the final polygon vertex.

QX700 ddPCR System Analysis Software draws the polygon with orange edges on the 2D graph,
and the droplets included in the polygon are highlighted in orange in the image.
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The following graphic shows a highlighted droplet population using a polygon drawn in the 2D graph.
Included droplets are highlighted in orange in the droplet image.

To exclude highlighted droplets from the analysis

1. In the Droplet Exclusion widget, tap/click Select for exclusion.

2. To exclude droplets in the highlighted polygon, right-click on droplets in the droplet image to select
them.

3. Tap/click Exclude to remove the droplets from the analysis.

As shown in the following image, manually excluded droplets are identified with yellow hexagons in
the crystal images and are removed from the dot plots.

To restore all manually excluded droplets

u In the Droplet Exclusion widget, tap/click Restore.
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The View Results view contains the Results Table (results collected and calculated from each RDG16
cartridge chamber in the QX700 experiment run) and Advanced Graphs, which contain concentration and
uncertainty curve graphical displays.

n Results Table—contains experiment details and results.

The default view contains the chamber name, quality control flag, protocol identifier, total (Nb) droplet
count, dilution factor, target concentration (copies per µl), and positive (Nb Pos) droplet count. You
can also extend the view to include negative droplets, separability score, minimum and maximum
copies per µL, and relative uncertainty at a confidence interval of 95%.
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n Advanced Graphs—contains graphics for concentration and uncertainty curves (confidence
intervals.

o Concentration graphs illustrates the copies per µL using a line and a data point for each selected
chamber. You can choose to display the data in linear or logarithmic scale.

Important: In the Settings widget, the Population section displays a maximum of three
channels simultaneously. Click in a channel field to display the dropdown list, and select a
different channel if applicable.
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o Uncertainty Curves illustrate the variability associated with quantification of targeted nucleic
acids at different concentrations. The data appears in a single arc for individual, multiple, and
pooled selections.

A legend also identifies elements in the display (uncertainty curve line, estimated chamber
concentration, optimal concentration to minimize uncertainty, and dynamic range limits).
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You can select a single chamber, or you can select merged chambers that appear as a collective
curve. The following graphic shows the uncertainty curves with multiple chambers selected.

You can also select parent or subordinate pooled chambers. When you select the parent, as
shown in the following graphic, the arcs are adjusted to show the data points for the pooled data.
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Viewing the Result Table
For each chamber, the Result Table view contains the total number of droplets, dilution factor,
concentration, and positive droplets. You can also expand the table to show the negative droplets,
separability score, minimum and maximum copies per µL, and relative uncertainty at a 95% confidence
interval.

If the sample dilution factor in the PCRmix is specified, the estimated concentrations are those of the
DNA target molecule in the initial stock, in copies per µL. For example, if the sample has been diluted 10x
in the PCRmix, then the field should contain 10 as the dilution factor and the stock concentration is equal
to the chamber concentration, multiplied by 10.

Important: If the dilution factor has not been specified, then it is set to 1 by default. This indicates that
the estimated concentration is the concentration in the loaded mix (the concentration of the target
molecule in the chamber) and not the initial (stock) concentration.

To obtain the concentration results

1. Click View Results >  Result Table.

QX700 ddPCR System Analysis Software computes the absolute nucleic acid concentrations based
on the standard Poisson statistics that are commonly used in ddPCR.

2. Click Result Table to view the concentration data.

Column titles are color-coded to coordinate with the corresponding fluorophore (channel) color (Blue
for the FAM channel, Teal for the HEX channel, and so forth).
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3. To expand the table to display additional data columns, click the chamber icon.

4. The total number of chambers belonging to the experiment is specified above the left pane. You can
also click the icon to display additional data columns.

5. Use the bottom scroll bar to scroll right or left and view results for all populations.

Tip: You can copy and paste the results to an Excel spreadsheet.

6. Click View Protocols to display a pop-up containing the thermal cycling protocol information. If more
than one protocol is assigned, a tab appears for each.
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Quantifying Fluorescence Separability
QX700 ddPCR System Analysis Software automatically computes the separability score, which is
provided for each detection channel and displayed in the Results Table extended display.

Separability scores are used for both quality control and assay optimization. The higher the score for the
droplet population, the better the amplification efficiency for the target of interest. A low separability score,
or a decrease in a previously characterized separability score, can signal a quality issue that is impacting
the PCR amplification efficiency; for example, using an incorrect PCR program, sample degradation, or
incorrect probe/primer concentrations.

Note: The separability score is only one parameter that is evaluated when optimizing assays. You
must confirm proper quantification using known quantities of positive controls. For example, the
separability score for any given channel could be high, but if the reaction is not specific to the desired
target, the target quantification might be incorrect. For more information, see Using the Separability
Score for Assay Optimization on page 113.
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To expand the column display

u In the View Results > Results Table display, tap/click the Chambers icon to show the column
containing the separability scores.

The separability score is an objective measure of the separation of positive and negative clusters of any
given amplified target in a sample. The score is based on the distance between the positive and negative
clusters and the positive and negative cluster spreads, as shown in the following graphic:

In this example

n The positive droplet cluster includes the amplified target of interest, so a high fluorescence intensity is
displayed.

n The target of interest is absent from the negative droplet cluster, so the fluorescence intensity is low
compared to the positive cluster.

The following bullet points describe the separability score values:

n For the FAM (Blue) channel, a separability score of 4 is the minimum acceptable value to distinguish
clearly and set the threshold between the positive and negative clusters on a 1D dot plot.

n The separability score is low for the FAM (Blue) channel because of the addition of the reference dye,
fluorescein. Fluorescein allows detection of the droplets by the analysis software, but increases the
background signal (negative population fluorescence) in the FAM channel.

n For all other channels, a separability score above 8 is acceptable, depending on the assay and the
fluorophore used.
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Using the Separability Score for Assay Optimization
Unoptimized PCR conditions can yield more than one distinct positive population, which can make
defining a threshold difficult and cause inaccurate quantification of the target of interest.

Sub-optimal PCR conditions can result in "rain," which are droplets of intermediate fluorescence due to
inefficient amplification, as shown in the following graphic:
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You can use the separability score to

n Determine the optimal elongation temperature common to all target amplifications. The score is
critical for assay optimization because unoptimized probes and primers can cause undesired probe
and primer interactions, such as non-specific amplification that can lead to a distinct second
population.

n Optimize assays and help determine the ideal PCR conditions that are common for all primers and
probes used in an assay.

n Determine the optimal probe/primer concentration at which there is good separability between the
positive and negative clusters witgh no performance loss. To reduce assay complexity and the
overeall quantities of reagents required for the reaction, it can be especially useful to determine the
lowest concentration of required probes/primers.

n Evaluate the assay performance. For example, if the Separability Score was 4 in the FAM channel,
but rose to 6 after changing the elongation temp from 59 °C to 61° C, then a potential improvement in
the assay is indicated.

Note: To evaluate the impact on assay performance, a comparison of the Separability Scores
before and after making a reaction change should be done for all channels.

Interpreting Uncertainty Curves
For individual, multiple, and pooled chambers, you can view the curve of relative uncertainty at a 95%
confidence level in the Advanced Graphs tab.

To view the graph

1. Select chambers, as follows:

n Single chamber

n Multiple chambers

n Pooled chambers, parent chamber or subordinate chambers
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2. Tap/click View Results >Advanced Graphs, and then select the Uncertainty Curves tab.

The 95% relative uncertainty curves (as shown in the above graphic) are displayed for each channel,
where

n The x-axis shows all possible chamber concentrations (in copies/µL).

n The y-axis shows the 95% relative uncertainty of the chamber concentration, which is based on the
total number of droplets analyzed in the currently selected chamber.

n The colored curve corresponds to the relative uncertainty curve of the currently selected chamber.
The higher the total number of droplets in the chamber, the lower the curve.

n The upper gray curve corresponds to the relative uncertainty curve of the chamber with the fewest
droplets.

n The lower gray curve corresponds to the relative uncertainty curve of the chamber with the most
droplets.

Note: If the two gray curves are the same, they can be obscured under the colored curve of the
selected chamber.

n The filled points located on the curve correspond to the predicted concentrations in the selected
chambers. You must distinguish between the chamber concentration and the stock concentration,
which is equal to the chamber concentration multiplied by the dilution factor.

n The white point located on the curve represents the chamber concentration, which minimizes the
relative uncertainty. This indicative value can help to estimate optimal dilution for the experiment.

Note: The white point is reached when ~79.7% of the droplets are positive, whatever the
number of droplets and the confidence level.
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Chapter 9 Post-Processing Changes
The following bullet points describe the Setup and Results submenus in the Post Processing tab:

n Setup—allows the user to specify the reference gene for each type of post-processing assay and for
each target population or gene. This can be identical for all target genes, or unique to each target
gene. Copy Number Variation (CNV), Mutant Allele Fraction (MAF), Gene Expression (GEX) and
Linkage Analysis are available for selection.

Important: Post-processing for large data sets can take more time. A "waiting" animation
(spinner) appears to alert you that the data is still being processed.

n Results—contains the total droplet count for each chamber, plus recalculated experiment details
from the post-processing analysis.

Note: The post-processing Results table is populated with data from one experiment type at a
time. If you select a different experiment type and recalculate, the existing columns and data are
overwritten with the recalculated data.
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Chapter 9 Post-Processing Changes

Performing Post-Processing Analysis
In the Setup view, you can specify settings to recalculate data for the Copy Number Variation (CNV),
Mutant Allelic Fraction (MAF), and Gene Expression (GEX) experiment types, and also for Linkage
Analysis. When you select an experiment type on the left, the calculation formula appears with a brief
explanation. The Settings dialog, where you can add populations and define references, appears on the
right. Each Settings dialog is tailored to the experiment type selected.

Fig. 7: Post-processing example

Fig. 8: Post-processing example, Linkage Analysis

Important: Linkage analysis is always calculated at a dilution factor of 1.
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Performing Post-Processing Analysis

The Results view contains the updated data after the post-processing algorithm recomputes the data for
your selected target and reference inputs.

Important Notes:

n If you select Gene Expression, you must calculate the geometric mean manually.

n Post-processing calculations can take a few minutes. The QX700 ddPCR System Analysis Software
displays a processing animation to alert the user that the software is computing data.

n Linkage analysis is not available when you define thresholds using polygons.

To perform a post-processing analysis of the results

1. Select Post Processing > Setup, and then select an experiment type.

2. In the Settings dialog on the right, choose a population, and then tap/click Add population to
processing.

3. Repeat to add more populations.

Table 14 on page 120 describes the options available for each experiment type, and Linkage Analysis, to
perform post-processing analysis.
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Chapter 9 Post-Processing Changes

View CNV MAF GEX LINK

Under Settings, you can select and add populations
sequentially; select a population in the left column, and
then tap/click Add population to processing.

X X X

Under Settings, you can select the channels used for
the linkage analysis assay.

Tap/click each drop-down arrow to select a different
channel.

X

Under Settings, the selected color is also used in the
Results Table.

X X

By default, the FAM channel appears in the Reference
column.

1. To modify, tap/click FAM and select a reference from
the dropdown list.

Note: If you select the Use same for all targets
checkbox, then the reference chosen first is
applied to the other populations.

X X

Table 14. Post-processing options
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Performing Post-Processing Analysis

View CNV MAF GEX LINK

Under Settings, to select one or more reference genes
for the same target gene, double-click the Reference
column.

Note: If several reference genes are selected, the
GEX ratio is calculated using the geometric mean
of the selected reference genes.

X

To specify the Cn reference value (set at 1 by default),
double-click a line in the Cn Ref column and enter a
value, and then press Enter.

X

You can select a custom reference per target or use the
same reference for all targets.

X X X

When you click Apply, post-processing calculations are
launched.

X X X X

Values are displayed in the Results tab. In addition to
the experiment parameters, only the following appear:

n For CNV, only the Cn ref and CNV values

n For MAF, only the MAF values

n For GEX, only the GEX value

n For Linkage Analysis, only the concentration and
values of relative abundance in %

X X X X

Table 14. Post-processing options, continued
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Chapter 9 Post-Processing Changes

View CNV MAF GEX LINK

To extend the Results table and display confidence
interval and uncertainty percentage columns, tap/click
the chamber count icon to extend the display.

X X X X

To improve results readability, respect the order of the
different targeted genes on the intact gene fragment
from 5' to 3’.

X

Table 14. Post-processing options, continued
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Chapter 10 Exporting System and Analysis Data
Using the Export tab, you can select chambers and export corresponding default and selected experiment
data to selected file types and formats, as shown in the following graphic. QX700 ddPCR System Analysis
Software can export to .csv and .xlsx formats.

Note the following:

n You can select enabled data types from the list

n The grayed out data types are always exported

For information on the fields and other information that is always exported, as well as optional exports,
see Data That is Always Exported on page 124 and Data Available for Optional Export on page 128. For
information on exporting the Regulatory Report in .pdf format, see Using Premium Edition on page 15.

To export the data

1. In the menu bar, tap/click Export.

2. Select a file type (.csv or .xlsx).

3. Select each experiment element to export.

4. Tap/click Browse and navigate to the desired output folder.

5. Tap/click Export.

When the export concludes, the output folder opens by default.
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Chapter 10 Exporting System and Analysis Data

Data That is Always Exported
Important: if samples from different experiments (.niodata or .nioresult) are merged, the output
details might differ from this section.

The following data is always exported:

n Experiment details (csv file, Excel Experiment_Details sheet), including:

o Fluorophore and target names

o User comments

o Scanning parameters (exposure times in ms for each channel)

o Spillover compensation status (compensated or uncompensated)

o The QX700 ddPCR System Analysis Software edition used to export the data

o Timestamp of data export

o Thresholding type for the experiment (line vs polygon) and definition scope (common for all
chambers or Individual per chamber)

o Cartridge type

o Mix name

o Kit name

o Instrument configuration

o Standard experiment name (if applicable)

n Chamber details for each chamber (.csv file, Excel Chamber_Details sheet), including:

o Cartridge barcode, chamber position (A, B, C, and so forth), sample name

o Pooling ID (empty, if not applicable)

o Protocol tag

o Protocol name

o Sample type (U, N, P, or S) for each detection channel

Note: For sample type S, reference concentration in copies/µL is also included.

o Original experiment name

o QX700 ddPCR System Control Software edition used to export (standard or premium)
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Data That is Always Exported

o Scanning timestamp

o Serial number of the QX700 ddPCR System used to scan

o Index of cartridge position (slot 1, 2, 3 from left to right on the cartridge plate) and index of
cartridge plate at the time of the scan

o Cartridge model

o Droplet diameter (estimated average droplet diameter in microns)

o Number of manually removed droplets

Note: For information, see Exploring and Analyzing Droplets on page 100 and Performing
Quality Control on page 43.

n Results for each chamber (.csv file, Excel Results sheet), including:

o Cartridge barcode, chamber position, sample name

o Total number of analyzed droplets

o For each population:

n Sample type (only in line thresholding mode)

n Dilution factor (N/A if not applicable)

n Estimated stock concentration (in copies/µL), using the following rounding rules:

o If c > 1000 cp/µL, the estimate is truncated

o If c > 10 cp/µL, the estimate is rounded to one digit

o If c < or = 10 cp/µL, the estimate is rounded to two digits

n Number of positive droplets

n Number of negative droplets (if not specifically defined as negatives in the population)

n Separability score

n Min and max limits of the 95% confidence interval for the estimated stock concentration (in
copies/µL)

n 95% relative uncertainty for the estimated stock concentration (equal to the 95% confidence
interval divided by 2x the estimated concentration)
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Chapter 10 Exporting System and Analysis Data

n Post-processing

o Post-processing setup for the experiment (.csv file and PP_setup sheet in Excel file):

o Post-processing analysis type

n Target population

n Reference population

n Cn reference value (CNV analysis)

n Channels used in linkage analysis

n Post-processing results for each chamber (.csv file and PP_setup sheet in Excel file):

o Chamber name

o Pooling ID

o Protocol name

o Total number of analyzed droplets

o For each CNV calculation:

n CN ref value

n CNV value

n Min and max limits of the 95% confidence interval for the CNV value and 95% relative
uncertainty for the estimated CNV value

o For each MAF calculation

n MAF value

n Min and max limits of the 95% confidence interval for the MAF value and 95% relative
uncertainty for the estimated MAF value

o For each GEX calculation:

n GEX value

n Min and max limits of the 95% confidence interval for the GEX value and 95% relative
uncertainty for the estimated GEX value
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Data That is Always Exported

o Linkage analysis:

n For the total fragment:

o Estimated stock concentration (in copies/µL)

o Min and max limits of the 95% confidence interval for the estimated stock concentration
(in copies/µL)

o 95% relative uncertainty for the estimated stock concentration (equal to the length of
95% confidence interval divided by 2 times the estimated concentration)

n For the the intact fragrment or all the other combinations of channels:

o Estimated stock concentration (in copies/µL)

o Min and max limits of the 95% confidence interval for the estimated stock concentration
(in copies/µL)

o 95% relative uncertainty for the estimated stock concentration

o Relative abundance (%)

o Min and max limits of the 95% confidence interval for the relative abundance and 95%
relative uncertainty for the relative abundance

n Zone Details (.csv file Excel Zone Details sheet), including details for each fluorescence zone

o Chip barcode and chamber position, sample name

o Zone ID

Note: In line thresholding mode, there are always two fluorescence zones where N is the
number of detection channels in line thresholding mode, where there is one zone per user-
defined polygon in polygon thresholding mode.

o Zone type, (quadrant in line mode, polygon in polygon mode)

Applicable to 3-color experiments only, as follows:

n The x and y channels are used to define the zone and the z channel (where Chan1 = Blue,
Chan2 = Green, Chan3 = Red)

n List of x–y coordinates of the 2D points defining the zone (in line thresholding, there are
always five (5) points defining a square)

n Zone coordinates for the z boundaries (In polygon thresholding mode the z-values for the
boundaries are always 0–65535 RFU)
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Chapter 10 Exporting System and Analysis Data

n Population Details (.csv file or Excel Population_Details sheet), including details for each population

o Population name

o Population color (RGB values)

o List of the zone IDs where the populations have been built

o If applicable, list of Zone IDs, specifically defined as negatives for the population

Data Available for Optional Export
Optionally, you can export the following data:

n QC Indicators (.csv file or Excel QC_Indicators sheet), including the following for each chamber:

o Cartridge barcode (chamber position and sample name)

o Quality flags

n Advanced QC Indicators (.csv file or Excel QC_Advanced sheet), including the following for each
chamber:

o Cartridge barcode (chamber position and sample name)

o In line thresholding mode only:

n Automated threshold values for each channel

n Manual threshold values for each channel

o In line and polygon thresholding modes, for each droplet population

n Dimensions (channel ID to define the zone, where 1 = Blue, 2 = Green, 3 = Red, and so
forth)

n Separability score

n µ pos (mean of the fluorescence values of the positive droplet population computed in 1D,
2D or 3D, depending on the number of channels used to define the population)

n µ neg (mean of the fluorescence values of the negative droplet population, computed in 1D,
2D or 3D, depending on the number of channels used to define the population)
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Data Available for Optional Export

n std-dev pos

o For 1D defined populations, L1 standard deviation of the positive droplet fluorescence
values in 1D

o For 2D or 3D defined populations, mean of the projected distances between the positive
droplet fluorescence points and their center in 2D or 3D, along the axis defined by the
positive population center and the negative population center in 2D or 3D

n std-dev neg

o For 1D-defined populations, L1 standard deviation of the negative droplet fluorescence
values in 1D

o For 2D- or 3D- defined populations, mean of the projected distances between the
negative droplet fluorescence points and their center in 2D or 3D along the axis defined
by the positive population center and the negative population center in 2D or 3D

n Droplet-level data (.csv) files for each chamber, each population – by default, the FAM (Blue)
channel, ROX (Green) channel, and Cy5 (Red) channel populations – and each compensation status
(compensated and not compensated)

Each file includes one line per droplet and for each droplet the file contains

n The x and y coordinates of the droplet center in the chamber

n Fluorescence values (in RFU) of the droplet in each channel

n Numerical index of the droplet

Each chamber includes

n One general file which contains the information of all the droplets analyzed in the chamber.

n Two population-specific files for each population (named XXX), as follows:

o File name for the first file = XXX_POS, which contains the information for the droplet subset
defined as positive for the population of interest

o File name for the second file = XXX_NEG, which contains the information for the droplet
subset defined as negative for the population of interest

n Spillover compensation file (.ncm format), including:

o Translation vector for the fluorescence background in each channel

o Excitation matrix for the degree of excitation of each fluorophore by each LED
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Chapter 10 Exporting System and Analysis Data

n Droplet images (.png format in 8 bits), including the images of each chamber in each channel

n Dot plots (.png format); in the relevant channels, this includes

o 1D dot plots for each chamber

o 2D dot plots for each chamber

o Concatenated (side-by-side) 1D graphs with all the chambers in sequential view

o Concentration graphs

o Uncertainty curves

o Droplet fluorescence histograms

n Plots configuration file, exported in .ncp format (includes the histogram, 1D and 2D dot plot
configurations

n Analysis template file (exported in .nca format); including the following information as data analysis
parameters):

o Manual or automated thresholding strategy

o Thresholding mode and scope

o List of the populations (default or custom) with their name, color, and zones

o Coordinates defining each zone – only the coordinates associated with the first chamber of the
current experiment are saved; these coordinates will apply to each new chamber of any further
experiments

n If the zoning mode is set to Individual per chamber, then you can specify the chamber with the zoning
configuration to be exported in the .nca file
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Data Available for Optional Export

Note the following:

n Exporting all chamber images or graphs extends the data export timeframe.

n The indicative size for the exported chamber images in .png format is 3 MB per channel per chamber

n From each display, you can save image and plot views using the following icons:

o Save as an image file (.png)

o Save as a vector file (.svg)

o Copy to clipboard

To save the file

1. Click the applicable image or plot.

2. Click File > Save or Save as and follow the prompts.
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Appendix A Software Installation
As part of the Bio-Rad qualification protocols, a field service engineer (FSE) sets up the instrument, installs or
upgrades your Premium Edition software, and activates the software licensing. You can also install the
software on additional PCs to facilitate plate setup and experiment data analysis while the instrument is
executing ddPCR runs. See PC System Requirements on page 133 for the minimum system requirements.
Beginning with Version 1.5, each software edition is installed from its own installer file.

Premium Edition is designed to provide more validation rigor if configured correctly, and requires the QX700
Data Service and additional configuration to satisfy regulatory requirements associated with CFR21 Part 11.
Instructions are included in this chapter but you should contact Bio-Rad Technical Support for assistance and
to answer any questions.

Important: Correct configuration for CFR21 Part 11 is the customer's responsibility.For information, see
21 CFR Part 11 Compliance on page 15. The QX700 Droplet Digital PCR System is for research use only
and is NOT intended for diagnostics.

PC System Requirements
To utilize the experiment setup and analysis capabilities while runs are being performed on the QX700 Droplet
Digital PCR System, Bio-Rad recommends installing the software applications on one or more PCs that meet
the minimum requirements specified in Table 15.

Component Minimum requirement

Operating system Windows 10 or Windows 11 (64-bit), Professional Edition

RAM 16 GB (minimum)

Processors Intel Core i5 or higher, 2GHz or higher (minimum)

Graphics card NVidia GeForce GT 1030 or higher (or equivalent, recommended)

Screen resolution 1920 x 1080, aspect ratio 16:9 (minimum)

Storage 2 GB required for software installation

Table 15. Minimum PC requirements
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Appendix A Software Installation

Installing QX700 ddPCR System Analysis Software
You can upgrade QX700 ddPCR System Analysis Software on the instrument, and you can install the
edition you are using on aWindows PC. A Bio-Rad website user account is required to access the
installation zip file. If you do not have an account, go to bio-rad.com and click Register in the upper-right
corner to open the Sign in page. Scroll to and complete the required information in the New Customer
section.

Important: If you are installing the software on additional PCs to expand your run setup and data file
analysis capabilities, you must install the same software edition on each PC that is installed on your
instrument or the run files generated on the instrument will be incompatible with the software. If you
are using Premium Edition, you can only open files that were created while you were logged in.

Note: If your instrument or PC does not have a wireless connection enabled, you can install the
software from a USB drive.

Downloading the Software
To download the software

1. Open bio-rad.com and sign in with your customer account.

2. In the website landing page, type QX700 ddPCR System Analysis Software in the Search field and
then click the Search icon.

3. When the results appear, click the Software checkbox on the left, under Products.

4. Click Download Software to download the zip file to the specified location.

5. Continue to Installing the Software.

Installing Premium Edition
Premium Edition requires the installation and configuration of the QX700 Data Service in addition to the
analysis software, and should be managed by a Bio-Rad FSE. If you prefer to install it yourself, contact
Bio-Rad Technical Support.

For Premium Edition,you must install and configure the , as well as the QX700 ddPCR System Analysis
Software.

u Locate and unzip the downloaded installation files, and then complete the steps to install the data
service and premium edition of the analysis software.

An installation Wizard is prompted when you tap/click the software installation executable file.
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Installing QX700 ddPCR System Analysis Software

To install the data service software

1. Right-click the installation executable file for the QX700 Data Service and select Run as
administrator.

2. Accept the license agreement and continue through the Wizard dialogs.

Note the following:

n The default folder is C:\Program Files\Bio-Rad\QX700DataService. You can keep the default
folder location (recommended) or tap/click Browse to navigate to a storage different folder.

n If you are performing an upgrade rather than a new installation, you must either confirm that you
are installing to the existing folder or designate a different folder.

n In the Service Options dialogs:

o Select Local, to authorize user accounts that are set up in Windows or Active Directory to
authorize users on your organization's network; if more than one PC will be set up to
connect to the instrument, then Active Directory is recommended.

o Tap/click Yes to import an existing Data Service database or No to skip the step.

o Identify or confirm the initial user and ensure Port 5034 is specified for the data service.

3. Click Install to begin the installation and display a progress bar.

4. When the installation concludes, click Finish.

5. (Optional) Restart the computer now or later.

To install the Premium Edition analysis software

6. Right-click the installation .exe file and select Run as administrator.
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Appendix A Software Installation

7. The default folder path is C:\Program Files\Bio-Rad\QX700Analysis. You can keep the default
(recommended) or you can click Browse and navigate to a different folder location.

8. Click Next.

If you are performing an upgrade rather than a new installation, a message appears asking you to
confirm that you are installing to the existing folder.

9. Click Yes to confirm.

10. If you are installing Premium Edition, ensure the Host and Port fields contain localhost and 5034,
respectively. Otherwise, continue to the next step.
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11. Select Create a desktop shortcut, and then click Next.

12. Click Install.

User Guide | 137
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The wizard displays an installation dialog with a progress bar.

13. When the installation concludes, click Finish.

14. (Optional) Restart the computer.
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Appendix B Remote Maintenance
To enable remote software maintenance on the QX700 Droplet Digital PCR System, ensure that

n The PC is turned on and connected to the internet

n Team Viewer is installed on the instrument

To start a remote maintenance session

1. Double-click the Team Viewer icon on the PC desktop.

2. Send the user ID and password by email to support@bio-rad.com (U.S./Canada Only)

Note: For technical assistance outside the U.S. and Canada, contact your local technical
support office or click the Contact us link at www.bio-rad.com.

You must have the following information available:

n Software version (available in File > About)

n Log files that have been generated in the following directory:

%USERPROFILE%\Public\Bio-Rad\<software name>\logs
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